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Congratulations on selecting the only MS WINDOWS offline mail reader that effortlessly handles 
both QWK and Blue Wave mail packets. We hope you'll find the MDI interface easy to use and find 
answers to any questions on setup or use in this help file. 



How To Register
WAVE RIDER is a user supported product. 

TO REGISTER BY CHECK:
To register WAVE RIDER, please send $50.00 (US Funds only) to:

Doug Crocker
P.O. Box 40026
Bellevue, WA 98005-4026

Note: Canadian users can write "US Funds" on their checks.

If you have already registered WinQwk, you need to send $15.00 (US Funds only) to the same address.

Washington residents please add 8.2 % sales tax.

TO REGISTER BY CREDIT CARD:
Name:        ____________________________________________

Name on Credit Card if different: ______________________________

Address: _______________________________ Apt. #: ____________

City:        ___________________________________________________

State/Prov:    _________    Zip:_________    Country:_________________

FidoNet Node:____________ Are you the sysop? _________________

InterNet Address: ___________________________________________

Daytime Phone Number:    _____________________________________

Evening Phone/Data Line Number: _____________________________

Credit Card Type:      ________ Visa

                                                            ________ Mastercard

                                                            ________ American Express

Credit Card Number: _________________________________________

Expiration Date: _____________________

Signature: __________________________________________________

NOTE: Our credit card registrations are handled via Dragon BBS of Vienna, OH.

____ $55.00 in US Funds. (Full registration, not update from WinQwk)

Washington residents please add 8.2 % sales tax.

____ $16.50 in US FUNDS. (Update from WinQwk)

Washington residents please add 8.2 % sales tax.

Disk format :    ____ 3.5" (HD)        ____ 5.25" (HD)

TO REGISTER ON COMPUSERVE:
On CompuServe, choose GO SWREG, and search for either Crocker, Doug, or by the SWREG number of
1626. NOTE: There is a surcharge added for this service of $7.00.

NOTE: $15.00 upgrades from WinQwk can not be handled on CompuServe, only the full original 



registration is available as it is impossible to provide an exe only for download for upgrades.

BENEFITS OF REGISTRATION:
Registered users will receive a waverdr.key file which should be placed in the same directory as the 
program files. This key file will enable taglines and remove the unregistered version notice. 

Additionally, registered users will receive the Wave Rider Extra Companion program (WRX.EXE), which 
includes tagline sorting, packet renaming, and database storage of exported messages using the MS 
ACCESS (tm) *.MDB file format. 

The Wave Rider Extra Companion program should be placed in the same directory as the Wave Rider 
program files. Documentation/Help will be included with the Wave Rider Extra Companion program.



How to obtain Support for WAVE RIDER
Support for WAVE RIDER can be found in the following places:

1.    On Crystal Cavern BBS, the home board for WAVE RIDER.    That phone number is:

(206) 883-8477
 A second phone line is available for registered users only:

(206) 883-7876
2.    In the FidoNet Waverdr, Windows or Offline echos.    Contact your sysop for access to those echoes. 
NOTE: The Waverdr echo is NOT on the backbone and must be requested from 1:343/105.

3.    On the    RIME WINDOWS and OFFLINE READER conferences.    Note:    The author does not 
receive messages from these places as frequently as others.

4.    Via Internet mail:

susanco@microsoft.com
5.    Via CompuServe:

72254,3143
6.    Via FidoNet Netmail:

1:343/105

NOTE:    There is no phone support for this product. 



Wave Rider    Program Files
The following files and programs are required to use Wave Rider:

WAVERDR.EXE
WAVERDR.HLP
ANSIVIEW.EXE
a zip and unzipping program if you don't use the internal routines supplied by WRUZ.EXE
The above files are the minimum files required to run Wave Rider.    Place the two EXE's and the HLP file 
in a separate directory and then run WAVERDR.EXE. You must setup the program first to find your mail 
packets and zip and unzip preferences (etc.) by completing the information in the OPTIONS MENU.
Additionally, the following DLL is supplied and should be installed to your \WINDOWS\SYSTEM directory:

VLIST.DLL
WRSPELL.DLL
To access Wave Riders spell checker, you will need the optional spell check files which should be placed 
in your WAVERDR directory:

DICT.D
DICT.I
DICT.S
DICT.U
DICT.APP
Wave Rider includes the capability to use WINDOWS based compression and uncompress routines 
which are compatible with PKZIP 2.04g and PKZIP 1.10. This requires the Visual Basic 3 runtime library, 
VBRUN300.DLL to be placed in your WINDOWS \SYSTEM directory. The main executable:

WRUZ.EXE
should be placed in your WAVERDR directory.

Additionally, the following files should be placed in your WINDOWS\SYSTEM directory:

COMPRESS.DLL
THREED.VBX
CMDIALOG.VBX
Registered Users will receive a WAVE RIDER EXTRA COMPANION program (which should be placed in
the WAVE RIDER program directory) named:

WRX.EXE
Please see Options (Setup) Menus for complete details on configuring Wave Rider for your system.

Additional files needed for WRX.EXE only
MSAJT110.DLL (Microsoft Access Jet Engine DLL)
VBDB300.DLL (Visual Basic Data Base Engine DLL)
MSAES110.DLL



    An Introduction to Mail Readers
If you've never used an offline mail reader previously, the following information covers the bare 
basics.

The function of an offline mail reader is to allow you to read and reply to messages that travel through the 
BBS community and provide offline tools to view new files lists, bulletins, news and other information. 
You'll need a separate communications package to upload and download mail packets.

Mail packets generally contain compressed and indexed messages, organized into conferences or areas. 
You will need to use your communications program to download either a QWK or a Blue Wave mail 
packet (*.mo? *.tu? *.we? *.th? *.fr? *.sa? *.su?).    After you've read and replied to messages, you will 
again need to use your communications program to upload a *.REP packet (for a QWK compatible 
BBS/mail door) or *.NEW for Blue Wave. 

The Blue Wave format includes automatic renaming of packets at the BBS DOOR LEVEL. The current 
QWK standard does not but you may rename QWK packets by changing the "K" to any letter or number. 

Related Topics:
What is Blue Wave?
What is QWK?



What is Blue Wave?
Blue Wave is a system/protocol or method of indexing and reading mail packets on Bulletin Board 
Systems. (BBS). 



 What is QWK?
QWK is a system/protocol is a subset of an archiving protocol that includes indexing which has become 
the most widely used mail packet format within the hobbyist BBS community. 



Setting up the Wave Rider Program - Options    Menu
Before you can run WAVE RIDER, you must specify the location of files and directories needed to 
run the program. These directories must already exist, WAVE RIDER will not create new 
directories. 
These setup screens will save the information you enter in the WAVERDR.INI file which is stored 
in your WINDOWS directory. If you change the location of directory you store mail packets (etc.) 
you should re-visit these setup screens, but normally you only need to complete this information 
once. 

Related Topics:
PATH SETUP
REPLY SETUP
MISC SETUP
FILE SETUP
PACKER - ZIP/UNZIP    SETUP
FILTERS SETUP
BLUE WAVE OFFLINE CONFIGURATION MENU
TOOLBAR SETUP - TOOLBOX SETUP - ICON SETUP
ACCELERATOR KEY SETUP



PATH SETUP
The Wave Rider program files should be installed in their own unique directory, shown as WAVE RIDER 
PATH. For most users, the default will be C:\WAVERDR.

The MAIL PACKET PATH is the directory to which you download your Blue Wave or QWK packets, as 
specified in the setup for your communications program. (Sometimes termed a DOWNLOAD directory or 
path). 

The REPLIES PATH is the directory from which you normally upload your *.REP or *.NEW file with your 
own communications package. Wave Rider allows you to bulk mark and export selected messages to 
your hard drive (or you may save an individual message). 

If you specify an EXPORT MESSAGE PATH, messages will be saved in the directory you specified; if left 
blank, messages will be exported to the directory in which you installed Wave Rider. The Spelling 
dictionary/DLL would normally be placed in the same directory as the WAVE RIDER program files but 
optionally can be placed in a different directory. 

You may specify the complete path to this directory in the SPELLING DICTIONARIES PATH. 

Wave Rider automatically creates a sub directory for each mail packet opened (and removes it when the 
program is closed) beneath the MAIL PACKET directory. You may optionally specify another location in 
TEMP DIRECTORY. Wave Rider will create these temporary directories beneath the specified directory.



REPLY SETUP
Wave Rider allows you to customize the appearance of replies by using special formatting codes. The 
example below shows first letter of first name and first letter of last name followed by a '>' character as a 
delimiter. 

You can also specify a quote header (or 'message introduction') using    replaceable parameters (for 
example first name and last name) which Wave Rider will place at the start of your message. A Quote 
Header uses 'replaceable parameters' that substitute the first and/or last name of the person to whom you
are replying inside a custom string that you can prepare to 'personalize' your replies. Experiment, you are 
limited only by your creativity.

You can specify a standard signature which Wave Rider will use in outgoing messages when you select 
SIGN or use the signature icon. Use %N to designate a new line.

Checking the Auto Sign Messages box will automatically insert the signature you create in the position 
where the cursor was left before saving the reply.



MISC SETUP
If SHOW ALL AREAS is X'd, all conferences in a packet will be listed when the AREAS menu or icon is 
invoked; unchecked will list areas only in which there is mail. checking JUMP TO NEXT AREA enables 
you to go to the first message in the next conference with mail when you reach the end of messages in 
the conference you are currently reading.

 Checking CONFIRM REPLY SAVING tells Wave Rider to present a dialog box each time you close a 
reply asking you whether or not to SAVE that reply. Leaving this box unchecked results in an AUTOSAVE 
of all replies. If WRAP AREAS is X'd, reaching the end of the last message in the packet and selecting 
"NEXT" will open the first message in the first area. 

Checking IGNORE ALL CAPS IN SPELLER tells Wave Rider not to consider a word in all caps as a 
spelling error.

You may specify the default file type (Blue Wave, QWK, Mail Packet or All files) shown in the open file 
dialog box by setting this default. Mail Packet will display both QWK and Blue Wave Packets.

SAVE LAST READS allows you to specify whether Wave Rider automatically saves this information, 
does NOT save this information or asks you each time you close a packet to specify your preference for 
that packet only. 

You may also specify your preferences on whether or not to delete a mail packet when it is closed. You 
may select YES to automatically delete, NO to never delete, or ASK. When ASK is selected, when you 
close a packet, WAVE RIDER will display a dialog window asking you to select YES or NO on deleting 
this packet.



FILE SETUP
You can specify the location of a TAGLINES FILE, an address book or "MESSAGE TO" PICK LIST file, 
whether to ENABLE SOUNDS when personal mail is encountered (and the full path to a Filename for 
WAV File to be used when personal mail is encountered) and for the ANSI FILE VIEWER (the executable
called by WAVE RIDER). Note that alternative viewers may or may not work correctly with WAVE RIDER. 
If you don't have a sound card or just want a system beep to signify new mail, enter the name of a WAV 
file that does NOT exist (or any name). This will generate a beep.

Wave Rider will use any existing ASCII taglines file. Taglines are available only in the registered version. 
Often used subjects can be stored in the SUBJECT PICK LIST (in ASCII format). You can also specify a 
PICKLIST EDITOR (NOTEPAD.EXE is the default) to be used when the EDIT button is selected for an 
individual picklist.



PACKER - ZIP/UNZIP    SETUP
Wave Rider uses an internal zip and unzip routine (WRUZ.EXE). In the Packer Setup fields, type a full 
path (including drive and directory) and the switches as shown below. Internal zip and unzip requires 
VBRUN300.DLL runtime file to be present in your \WINDOWS\SYSTEM directory (usually available on 
most BBSes). Wave Rider uses WRUZ.EXE as a program default.

Example of Setup for internal zip routines:
OpenZip=C:\WAVERDR\wruz.exe %f %d -o 
CloseZip=C:\WAVERDR\wruz.exe %f %d -c
NOTE: -o is a lower case letter 'oh'

Additionally, Wave Rider requires three additional files to invoke internal zip and unzip routines. 

All three should be placed in your \WINDOWS\SYSTEM directory:

Compress.dll  - Compression Library routines (included in this zip)      

Threed.vbx      - Visual Basic File (included in the distribution archive)    

WARNING: there are at least three versions of this file currently available, we recommend strongly you 
use the one included in the Wave Rider distribution archive.

Cmdialog.vbx - Visual Basic File (included in this zip).

WARNING: there may be other versions of this file in circulation. It is again strongly recommended you 
use the one supplied.

Wave Rider supports    ZIP, ARJ, and LHA external compress and uncompress protocols. To use PKZIP 
as an external protocol, use the following command parameters (with the full path specified to the EXE's):

PKUNZIP.EXE %f %d                                              
PKZIP.EXE -m %f %d
NOTE: You can run PKZIP and UNZIP in a WINDOW rather than full screen by writing a PIF that specifies
to run in a window for each. Be sure to specify any necessary switches following the PIF.

Command line default switches for ARJ and LHA are shown below: 

WUNA may be used as an external UNCOMPRESS/UNARCHIVE only, use the following syntax and 
complete the full path to your WUNA program files:

wuna.exe -e -m0 -g %f -p%d



FILTERS SETUP
Many users prefer not to read or 'see' a listing of mail from selected individuals (sometimes known within 
the BBS world as twit lists or twit filtering) and/or prefer to skip over specific subject matter within their 
mail packets. WAVE RIDER provides this ability. From the OPTIONS menu, select FILTERS to display the
Filters dialog box: NOTEPAD is used by default to edit a filter list.

Type a full path and filename in the MESSAGE TO field to create an ASCII file of names for the Message 
To filter, then select EDIT. Notepad will display an empty window.    Enter the names you wish to 'ignore' 
and then select OK to save. Be sure to press [enter] between each name to create a hard carriage return 
between each name on the list if you enter names during setup). It's recommended you create this file in 
the same directory where you installed the WAVE RIDER program.

Follow the same procedures to create an individual filter file for MESSAGE FROM and MESSAGE 
SUBJECT and specify a unique file name for each type of filter.

NOTE: To add to a filter list when reading mail, you can select the name or subject, copy it to the 
clipboard, then access the OPTIONS menu. Select Filters, then the EDIT button for the list you wish to 
edit. You can then paste from the clipboard to the list. Save the list before exiting the notepad editor.



BLUE WAVE OFFLINE CONFIGURATION MENU
Blue Wave allows you to specify certain configuration parameters offline which are included in the *.NEW 
file which you can upload. You may select conferences and keywords, specify filters (for messages to be 
excluded) and toggle EXPERT Mode on or off. This menu item is not available unless you have an open 
Blue Wave packet.

You may select or deselect areas/conferences to be included in your mail packets from the list box on the 
right. Once you have made your changes/additions to your configuration, select OK. When you next 
upload your *.NEW file, these changes will be transmitted to the BLUE WAVE door and will be 
immediately effective. After processing any messages that you have    uploaded, you will see a message 
from the door indicating that it is processing your offline configuration request. If you want your 
configuration to    become active AFTER your current download session, you should upload the 
configuration after downloading your mail packet.

 



TOOLBAR SETUP - TOOLBOX SETUP - ICON SETUP
Wave Rider when first installed provides a default toolbar and toolbox which correspond to the needs ot 
an average user. Since personal preferences are important in a mail reader, both the toolbar and toolbox 
are completely user customizable and can be tailored individually. Three size icons are provided, and you 
may specify one size for the toolbar and a different size for the toolbox. To select the size icon you prefer, 
use your mouse and mark the selection you wish to use. 

Positioning of each icon is user changeable/selectable. The following dialog window is used to customize 
these features.

To add a function/icon to the last position, first highlight the function in the left hand window and then 
select add.
To insert a function/icon first highlight the function in the left hand window, then highlight the existing 
function/icon in the right hand window that the new function is to precede and then select insert.
To remove a function/icon, first highlight the function in the left hand window you wish to remove and then 
select remove.

To remove all functions/icons, select clear all.

When you have completed making changes, select OK to return to Wave Rider. If you change your mind, 
select Cancel.



ACCELERATOR KEY SETUP
Wave Rider allows you to select or even redefine what accelerator (also known as hotkeys) are utilized to 
perform specific tasks. For example,    function key F5 is pre-assigned to invoke the ansiview program (or 
view ansi message). You can change this using accelerators key setup. 

In the sample below, function key F10 is assigned to open the PERSONAL MESSAGES list.

To prepare to assign a key to a function, first check to see if the key combination is already assigned by 
pressing the key combination you wish to use. If this particular combination is already assigned, Wave 
Rider will jump to and highlight that function in the listbox for you. If you want to reassign to another 
function, first use remove key to clear that key for use elsewhere. highlight the function and then select 
remove key. 

To assign a function to an accelerator, highlight the function, then press the key or key combination you 
wish to use (if available it will immediately be shown in the ASSIGN TO box) and then select ASSIGN.

To remove ALL key assignments and return to program defaults, select CLEAR ALL.

Select SAVE to save all changes made and return to Wave Rider or CANCEL to not implement changes.



Customizing - Fonts, Toolbar/box, Windows, Status 
Bar

Choose Font dialog box
The Toolbar and the Toolbox
Saving Window Sizes
Status Bar



Choose Font dialog box
Wave Rider will display messages in any installed font available on your system and will allow you to edit 
messages using any monospaced font on your system (normally monospaced fonts do not use True Type
font technology, although there are exceptions such as the TT Line Draw font available on the Microsoft 
Download Service).

While reading incoming mail, select the VIEW Menu then Fonts. The select font dialog box will allow you 
to preview fonts before selecting OK.

While preparing a reply or a new message in an edit window, select the VIEW Menu, then Fonts. You will 
be able to preview the various monospaced fonts installed on your system.

Please note that the selected font(s) will not be transmitted with your REP or NEW reply packet as only 
ASCII/ANSI characters will be transmitted. 



The Toolbar and the Toolbox

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Wave Rider. The floating toolbox provides the same 
type of functionality as the toolbar but can be positioned according to your personal preference. 

Both the toolbar and the toolbox display an array of small icons which represent the basic functions 
needed by most users. Note that the toolbar and the toolbox are individually and independently 
customizable. You may select which icons/functions to display, the position in which to display them, and 
you may select one of three sizes. See Toolbar Setup for help on customization.

The default toolbar and toolbox allow you to quickly access functions as described below. Note that as 
you move your mouse over a toolbar or toolbox icon, the status bar will display a message describing the 
function of that icon.

Click       To

Write a new reply without having an open packet. 

    Open an existing mail packet. 

Close the open window, reply, group of marked messages, or packet

 Save/Export the active message or reply.    

 Removes selected data and stores it on the clipboard.

 Copy the selection to the clipboard.

 Insert the contents of the clipboard at the insertion point.

Print the active message or reply.

Click to read previous message

Click to read next message

Click to Page Down

Click to Page Up

Click for Previous Conference

Click for Next Conference

Reply to Current Message

Write a New Message or Edit a reply

Shows areas in current packet

Shows messages in current conference

Signs message at cursor position

Spell Checks the current reply



Steal tagline from current message

View Ansi Message

Open the Help File



Saving Window Sizes
Wave Rider automatically saves the position and location of the main Wave Rider program window.

Wave Rider offers you the option to save your preferred window size for both reading mail and writing 
replies. To save the window size while reading incoming mail, first size the window to meet your 
preferences. Next, select the Window menu and then SAVE POSITION. Window size for replies is saved 
separately. To save the reply window size, while writing a reply, size the window to your preferences and 
then select the Window menu and finally SAVE POSITION . Maximized window setting are not saved. 
Wave Rider saves the underlying window size.



Status Bar

The status bar is displayed at the bottom of the Wave Rider window.    To display or hide the status bar, 
use the Status Bar command in the View menu. 
The Status Bar, when active, will display the function of a toolbar icon when the mouse is moved to a 
position over any individual toolbar icon. 
The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus. The right areas of the status bar indicate which of the following keys are latched down:

Indicator              Description
CAP          The Caps Lock key is latched down. 
NUM          The Num Lock key is latched down. 
SCRL        The Scroll Lock key is latched down.

 



Opening and Reading Mail Packets
Opening, Renaming, and Deleting Mail Packets
Areas (Conferences) Menu
Messages Menu
Marking and Manipulating Messages
Searching for Text



Opening, Renaming, and Deleting Mail Packets
Select the open packet icon or open from the file menu to display a list of mail packets. Highlight a packet 
and select OPEN to begin reading mail from this packet. Highlight a packet and then select RENAME to 
rename a packet, and highlight and select DELETE to delete a packet.



Areas (Conferences) Menu
After opening a mail packet, you may select a specific area or conference in which to read messages 
from the areas menu from the main menubar.    You may navigate to the next or previous area, or view 
Personal Messages. 

 

Selecting List from the Areas Menu will display the Areas (conference) dialog box from which you can 
select and navigate to a different area. You can Add a Conference or Drop a Conference from this dialog 
box. Note that you may view replies by selecting the Areas Menu, then Replies.    

From the Areas dialog box, you may select a new area or conference, and then double click to move to 
this conference. 

From the Areas List, you can specify to ADD A CONFERENCE or to DROP A CONFERENCE by first 
unselecting (if necessary) to show only conferences or areas with mail and then select a conference to 
ADD by highlighting it with the cursor and selecting the ADD button. To DROP a conference, highlight with
the cursor and then select DROP. (You can verify that a marker has been placed in your REP packet by 
selecting the AREAS MENU, then replies. Most BBS systems that are QMAIL or TOMCAT compatible will 
accept these ADD or DROP instructions in a REP packet.

PERSONAL MAIL is displayed as an area or conference in the conference list. You may easily view all 
personal mail by displaying the Areas Menu and then selecting PERSONAL MAIL. 

REMINDER: To review replies you have created, you must select the Areas menu and then select 
Replies; replies are not accessible from the Areas Window. 



Messages Menu
After you have opened a Mail Packet, Wave Rider allows you to sort and manipulate messages within a 
conference or area either from the Messages Menu or from the Messages Icon.    

LIST will display the Message List box, NEXT will display the next message, PREVIOUS will display the 
prior message. EXPORT allows you to print to disk. SORT allows you to select SUBJECT, MESSAGE 
TO, MESSAGE FROM, etc. 

ENTER allows you to write a NEW message in this 'thread', REPLY automatically displays a reply window
with the fields for recipient, subject and conference/area already completed. 

GET TAGLINE (enabled only while reading messages) allows you to 'steal' a tagline and will invoke a 
dialog box that enables you to edit the stolen tagline before saving it. 

(NOTE: When you are replying or entering a new message, the MESSAGES Menu adds SPELLING and 
SIGN to the available menu selections so that you may spell check and use your predefined signature.)

After selecting LIST messages, you may then MARK messages for reading, exporting or printing.



Marking and Manipulating Messages
From the Message Window, you may select an individual message by clicking on it twice to read it. To 
Mark a series of messages for reading, exporting of printing, Hold down the CONTROL KEY and click on 
the messages you wish to read, etc. (NOTE: not applicable to printing).

Messages will be highlighted. Select READ MARKED to read,    or EXPORT to print to a file (you can 
save several messages at the same time to a single file). When you select EXPORT, Wave Rider opens 
the standard file save dialog box and allows you to accept a default file name or change the file name as 
well as the drive and directory. Select CANCEL to return to the open message without taking any action 
and select OK to read the message under the cursor. You may move forward or backward in the open 
conference after selecting a single message with this method.



Searching for Text
Wave Rider makes it easy for you to find information and subject matter you wish to read. 

Find command (Edit menu)
After you have opened a mail packet, you can selectively search for text that meets your criteria by using 
the Find command on the Edit menu. Selecting FIND will display the Find Dialog box

Find dialog box
Wave Rider will search for the text or text string you designate within the message subject, message 
body, To: or From: fields. If the target string is found in multiple messages, Wave Rider auto marks these 
messages and displays them so you may view them consecutively. Wave Rider remembers your last ten 
search 'arguments' and will display them as a pick list. This is especially useful if you regularly search for 
the same words or phrases.

 



Replying,    Entering Messages and Saving Messages
Entering a new message
Replying to a message
Viewing replies
Edit Replies
Deleting Replies
Carbon Copies
Saving Messages



Entering a new message
To enter a new message, select ENTER from the messages menu or the new message icon (CTRL-E).



Replying to a message
First, while reading an incoming message select REPLY from the Messages Menu or the reply icon    
(CTRL-R) to open an edit window for your reply.

When you reply to a message using Wave Rider, all text from the message you are replying to is pasted 
into the Wave Rider editor using any quote characters and delimiters you have specified in setup. You can
delete (cut) any text you do not wish to include in your reply and change the spacing and layout of the 
message. To SAVE your reply, click on the close bar or the 'close folder' icon when done.



Viewing replies
To VIEW REPLIES you've already entered, first select the AREAS icon or menu which displays any 
existing replies along with the conferences list. Then select REPLIES. To select individual replies to view, 
select the messages icon. 

To write a NEW message while a packet is open, select the NEW message icon (or press CTRL-E to 
ENTER a new message). If you do not have a packet from the BBS OR an existing REP reply packet for 
that BBS, you may enter a new message by selecting NEW from the File Menu.



Edit Replies
To edit a previously saved reply, select the AREAS MENU, Personal, Messages, List, highlight the 
message you want to edit, and choose Messages, Edit. (Or, click on the multiple file folders, select 
Replies, use the left-right arrows to select the message you want to edit, and click on the single pencil.)



Deleting Replies
To DELETE A REPLY, select    the AREAS icon or menu, then select REPLIES. Next, select the 
messages icon or menu which will display the listbox of all existing replies. Place the cursor on the 
message you wish to delete to highlight it and then select the delete radio button. 



Carbon Copies
Wave Rider includes routines to send blind carbon copies and can utilize and create email distribution 
lists. To send blind carbon copies, after you have completed your reply, from the Messages Menu, select   
Carbon Copy.

The Carbon Copy dialog window will display:

Manually type a name in the edit field shown as [1], then select add [2] which places this name on the 
blind cc list shown in the distribution list window [7]. Repeat if you wish to add additional names. If you 
change your mind and wish to REPLACE the person you just copied, type a different name in field [1] and
then select [3] change. Select OK [4] to SAVE REPLIES and return to the read (incoming message) 
window when done. 

To use the powerful carbon copy list and list saving features of Wave Rider, Select [5] OPEN to display a 
list of TXT files. Any ASCII list can be used or created, one user name per line. If you create a special 
distribution list for an Email group and save it as CCLIST.TXT, the default carbon copy filename, select 
OK to display this list in Address File List field [6]. If you wish to open an existing file of addresses already 
created (such as your address book list for Wave Rider) change the extension in the dialog window and 
then open the file by selecting OK. 

To specify a name or group of names that appear in the Address File List field [6] to receive copies of the 
reply in the message editor, highlight one or more (using file manager conventions, Shift + left mouse to 
select contiguous names or Control + left mouse to select non-contiguous names). When done, select the
[9] Add Individuals button (<). To add all names on a list displayed in the Address File List field [6], select 
the [10] Add All button (<<). When done, select [4] OK which saves all replies and returns you to the read 



(incoming message) window.

To create a permanent mailing list for blind carbon copies, manually type a name in the edit field shown 
as [1], then select add [2] which places this name on the blind cc list shown in the distribution list window 
[7]. Repeat until all names are shown in the distribution list window [7]. Highlight the names you wish to 
store in a permanent list and then press the Add Individual Names button [11] (>) which copies these 
names to the Address File List field [6] then select SAVE [13] and specify a file name when prompted. To 
add ALL names from the distribution list window [7], select the Add All Names button [12] (>>) which 
copies ALL names, and then select SAVE [13].

To DELETE a name from either window, highlight the name and press the appropriate DELETE button [8] 
or [14]. If you are creating a new permanent list, select SAVE [13].

To CANCEL the blind carbon copy process at any time, select the Cancel button [15].

Select OK [4] to save work and send carbon copy replies.



Saving Messages
There are several methods of saving messages/replies. Click the close box    or select the close message 
icon to display a dialog box which prompts you to save the reply/message you now have in the editor. You
may also select Save Replies from the File Menu to save replies.



Pick Lists 
The message header area in includes quick navigation drop down lists which display pick lists to help you
easily change the person TO whom you are replying, the SUBJECT of the message, the AREA or 
CONFERENCE, and the TAGLINE you wish to use. Additionally, once you have specified a file name for 
TO, SUBJECT, and TAGLINE files in File Setup, you can easily add to these files from the message 
editor.

    Note that in the header, each field which can display a drop down list includes a down arrow icon. 
Selecting the icon displays the drop down list.

    To ADD the information in the TO, SUBJECT, or TAGLINE field to an existing list. Select the ADD 
ENTRY icon.



Ansi File Viewer

ANSIVIEW.EXE is a separate executable included with Wave Rider that is called from the ANSI ICON on 
the toolbar or by pressing F5. While reading any message, click on the icon or press F5. Then, from the 
ANSIVIEW File Menu you may access files as listed below if included in the current open mail packet. 
Due to the nature of this program, the maximum file size which can be opened with ANSIVIEW is 31990 
characters including the escape sequences. Only 25 files will be displayed (use FILE-Open if there are 
more than 25 in a packet). ANSIVIEW.EXE reads ESC and ` for use as escape codes and does not 
support the 2j clear screen code.

QWK support is limited to the following to the following, which will automatically appear on the ANSIVIEW 
File Menu if included in the current open packet:

Welcome.*

Newfiles.dat

News.*

Session.*

Blt*.*

Bluewave support is through the *.inf file. If this file does not have the files listed internally, an empty 
menu will be displayed.

This version of Ansiview best handles files designed to be seen as a whole.

If the file being viewed requires scrolling of the DOS console you may not get the results you expect.



Keyboard (Hotkeys)
WAVE RIDER offers quick keyboard navigation using default accelerator keys as follows: (You can 
redefine and specify aditional accelerator keys - see the help section for Accelerator Key Setup)

PRESS TO      
        CTRL-A                  View Area List
        CTRL-C                  Edit Copy
        CTRL-E                  Message Enter
        CTRL-L                   Message List
        CTRL-N                  File New
        CTRL-O                 File Open
        CTRL-P                  File Print
        CTRL-R                  Message Reply
        CTRL-S                  Save Replies
        CTRL-T                  Get Tagline
        CTRL-V                  Edit Paste
        CTRL-X                  Edit Cut
        CTRL-Z                  Edit Undo
        F1                        Help
        Shift F1          Context Sensitive Help 
        F3                        Edit Find
        F5 View Ansi Message
        F6                          Next Window Pane
        Shift F6              Prev Window Pane
        F8                        Message Sign
        F9                        Message Export
        Ctrl-Insert    Edit Copy
        Shift-Insert        Edit Paste
        Alt-Backspace    Edit Undo
        Shift-Del          Edit Cut

Windows Conventions & Wave Rider Menu Structure
Title Bar
Scroll bars
Control and System Menus
File Menu
Edit Menu
View Menu
Window Menu
Help Menu



Title Bar
The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

The Wave Rider title bar contains the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



 Scroll bars
Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Control and System Menus
Size command (System menu)
Move command (Control menu)
Minimize command (application Control menu)
Maximize command (System menu)
Next Window command (document Control menu)
Previous Window command (document Control menu)
Close command (Control menus)
Restore command (Control menu)
Switch to command (application Control menu)



Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move.    

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut

Mouse:    Drag the size bars at the corners or edges of the window.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut

Keys: CTRL+F7



Minimize command (application Control menu)
Use this command to reduce the Wave Rider window to an icon.

Shortcut

Mouse:    Click the minimize icon   on the title bar. 
Keys: ALT+F9



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse:    Click the maximize icon   on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)
Use this command to switch to the next open document window.    Wave Rider determines which window 
is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)
Use this command to switch to the previous open document window.    Wave Rider determines which 
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the current WAVE RIDER window or dialog box



Restore command (Control menu)
Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)
Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

When you choose the Switch To command, you will be presented with a 
dialog box with the following options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
Dialog Box Options
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title 
bar.    This option does not affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap.    This 
option does not affect applications reduced to icons.
Arrange Icons
Arranges the icons of all minimized applications across the bottom of the
screen.



File Menu 
WAVE RIDER uses standard WINDOWS 3.1 procedures to open, close, save and print (etc.) files. 
You can access all commands from the File Menu and most are also available by selecting icons 
on the TOOLBAR.

Related Topics:
The File Menu commands:
New command (File menu)
File New Dialog Box
Open command (File menu)
File Open dialog box
Close command (File menu)
Save command (File menu)
1, 2, 3, 4 command (File menu)
Exit command (File menu)



The File Menu commands:
New Creates a new reply packet without 

having to have a mail packet.
Open Opens an existing mail packet.
Close Closes an opened message or 

packet.
Save Replies Saves reply file on the fly.
Print Prints a Message.
Print Setup Selects a printer and printer 

connection.
Exit        Exits Wave Rider.

New command (File menu)
Use this command to create a reply packet without having to have an existing Blue Wave or QWK packet.

You can open an existing mail packet    with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New Dialog Box
This command allows you to enter a new REPLY even if you do not have a mail packet for the board you 
wish to create a reply for. You must have previously read mail from this board using Wave Rider so that 
an *.INF file was created for this board. The INF files provide a    listing of BBSes that Wave Rider has 
information about and will be displayed in a dialog box. You may enter a NEW message for any board on 
this list.



Open command (File menu)
This command is used by Wave Rider to open an existing mail packet. Using this command invokes the 
File Open Window which enables you to select the mail packet to open.

Shortcuts

Toolbar:                
Keys:      CTRL+O



File Open dialog box
The following options allow you to specify which file to open:

File Name Type or select the filename you want
to open.    This box lists files with the 
extension you select in the List Files 
of Type box. 

List Files of Type Select the type of mail packet you 
want to open: Blue Wave or QWK 
are your two choices.

Drives Select the drive in which Wave Rider
stores the file that you want to open, 
if not in the default drive which is 
automatically displayed. 

Directories Select the directory in which Wave 
Rider stores the file that you want to 
open if not in the default directory 
which is automatically displayed.

The dialog box displays a list of the mail packets in the default directory. Double click on the packet you 
wish to open.



Close command (File menu)
Use this command to close all windows containing the active packet.    

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)
Use this command to save your replies without having to close the mail packet.

Shortcuts

Toolbar:                
Keys:      CTRL+S



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four mail packets 
that you have previously opened. WARNING!    If you have since deleted that mail packet, this list is not 
corrected. Choose the number that corresponds with the document you want to open.



Exit command (File menu)
Use this command to end your Wave Rider session.    You can also use the Close command on the 
application Control menu.    Wave Rider prompts you to save documents with unsaved changes.

Shortcuts
Mouse:    Double-click the application's Control menu button.

Keys: ALT+F4



Edit Menu
WAVE RIDER uses standard WINDOWS 3.1 edit functions as found in most WINDOWS based 
applications. The WINDOWS clipboard is used for cut and paste operations. 

Related Topics:
Edit Menu Commands
Cut command (Edit menu)
Copy command (Edit menu)
Paste command (Edit menu)
Paste From File (Edit menu)



Edit Menu Commands
The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and 

moves it to the clipboard.
Copy Copies data from the document to 

the clipboard.
Paste Pastes data from the clipboard into 

the document.

Cut command (Edit menu)
Use this command to remove the currently selected data from the document and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:                
Keys: CTRL+X



Copy command (Edit menu)
Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:                
Keys: CTRL+C



Paste command (Edit menu)
Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:                
Keys:      CTRL+V



Paste From File (Edit menu)

Use this command from the Edit Menu to easily open *.txt files and paste (import from a text file) into the 
message or reply in the editor. Selecting this menu choice displays the common dialog box. You may 
change the extension as well as drive and directory and select any text file. The text will automatically be 
inserted at the cursor position.



View Menu
View Menu Commands
Toolbar command (View menu)
Toolbox command (View menu)
Status Bar command (View menu)
Font command (View menu)
Ansi Msg (View Menu)



View Menu Commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Font Change/view font used to READ mail
Ansi Msg View Ansi msgs and access ANSIVIEW

Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in Wave Rider, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.



Toolbox command (View menu)
Use this command to display and hide the Toolbox, which includes buttons for some of the most common 
commands in Wave Rider, such as File Open.    A check mark appears next to the menu item when the 
Toolbox is displayed.



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Font command (View menu)
Wave Rider allows you to select any installed font on your system to use while viewing (reading 
messages). For best results, it is recommended you select a monospaced font and not a proportional 
font.



Ansi Msg (View Menu)
While reading mail, ansi messages can be accessed from the View Menu by selecting Ansi Msg. This 
calls ANSIVIEW.EXE and will also allow you to access the packet menu for new files, bulletins, news, 
session data, etc., depending on the BBS door used and the information supplied in the current mail 
packet.



Window Menu
Window Menu Commands
New command (Window menu)
Cascade command (Window menu)
Tile command (Window menu)
Window Arrange Icons Command
Save Position
1, 2, ... command (Window menu)



Window Menu Commands
The Window menu offers the following commands, which enable you to arrange multiple views of 
multiple documents in the application window:

New Window Creates a new window that views the
same document.

Cascade Arranges windows in an overlapped 
fashion.

Tile Arranges windows in non-overlapped
tiles.

Arrange Icons      Arranges icons of closed windows. 
Save Position Saves Read or Reply Window Size
Window 1, 2, ...                Goes to specified window.

New command (Window menu)
Use this command to open a new window with the same contents as the active window.    You can open 
multiple document windows to display different parts or views of a document at the same time.    If you 
change the contents in one window, all other windows containing the same document reflect those 
changes.    When you open a new window, it becomes the active window and is displayed on top of all 
other open windows.



Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Window Arrange Icons Command
Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



Save Position
Wave Rider offers you the option to save your preferred window size for both reading mail and writing 
replies. To save the window size while reading incoming mail, select the Window menu and then SAVE 
POSITION. Window size for replies is saved separately. To save the reply window size, select the 
Window menu and then SAVE POSITION while writing a reply. 



1, 2, ... command (Window menu)
Wave Rider displays a list of currently open document windows at the bottom of the Window menu.    A 
check mark appears in front of the document name of the active window.    Choose a document from this 
list to make its window active.    Use F6 to switch panes.



Help Menu
Help Menu Commands
Index command (Help menu)
Using Help command (Help menu)
About command (Help menu)



Help Menu Commands
The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on 
which you can get help.

Using Help Provides general instructions on 
using help.

About Displays the version number of 
WAVE RIDER.

Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using WAVE RIDER and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of WAVE RIDER. 



WAVERDR.INI Settings
For users that like to 'look under the hood', following is a discussion of the settings that control 
how WAVE RIDER operates.
WAVE RIDER stores all the information you enter during program setup in a special file in your 
WINDOWS directory called WAVERDR.INI. Each section contains statements which pass 
parameters to WAVE RIDER that personalize the way the program works. Normally, all settings 
should be entered via the dialog boxes, but advanced users CAN make changes by editing this file
with a text editor.

Related Topics:
[Paths]
[Settings]
[Screen]
[Recent File List]
[Pick Lists]
[Packers]
[Sounds]
[ReadFont]
[Search]
[ReplyFont]
[Write Window]
[Read Window]



[Paths]
When you first setup Wave Rider, you entered settings in the Path Setup that specified where you store 
you mail packets, your reply packets, the spelling dictionary. and the program and related files.    This 
portion of the WAVERDR.INI reflects this information.

DefaultMailPath=C:\PROWIN\MAIL
This normally is the same as your communications program's download directory.

ReplyPath=C:\PROWIN\UP
This normally is the same as your communications program's upload directory.

ExportMsgPath=C:\WAVERDR
Wave Rider will export messages as ASCII (*.TXT) files. The default directory is the one in which 

you installed the program, but you may specify any other existing directory here.

SpellDict=C:\WAVERDR
Included with Wave Rider is the capability to spell check your new messages and replies. The 

spelling dictionary is normally placed in the same directory as the Wave Rider program itself, but may be 
placed in any existing directory and its location specified here.

Waverdr Directory=C:\WAVERDR
This is the main directory where the WAVERDR.EXE is located. If you move the program or 

change the directory name, this setting should be changed.

Temp Dir=C:\PROWIN\MAIL
Wave Rider creates a temporary subdirectory for each packet opened in a session UNDER the 

directory specified as DefaultMailPath and removes these directories when you exit the program. You 
may optionally specify any existing directory under the root directory.

Ansi Viewer=C:\WAVERDR\ANSIVIEW.EXE
The setting specifies the location of the EXE used to view ansi messages, bulletins, etc. from an 

open packet. The program ansiview.exe is included with the Wave Rider program and by default is 
located in the same directory as the WAVE RIDER program files.



[Settings]
QuoteHeader=-= %F wrote to %T on %D =- %N
QuoteHeader uses 'replaceable parameters' that substitute the first and/or last name of the person to 
whom you are replying inside a custom string that you can prepare to 'personalize' your replies. 
Experiment, you are limited only by your creativity.

QuotePrefix=%f%l>
QuotePrefix is used to identify in the body of your reply the initials of the person to whom you're 
responding. The character you specify after the "%f%l" (in the example here a ">") will appear 
immediately after the initials. As an example, if you were replying to a message from Doug Crocker, the 
first three characters of each quote line would read: DC>

DefaultSort=3
DefaultSort You can specify a variety of sort criteria, Message Subject, Message to, Message from, etc. 
To follow "threads" most people will want to use the default setting of MESSAGE SUBJECT. The setting is
saved in your ini file.

JumpAreas=1
JumpAreas: This setting indicates how Wave Rider will navigate when you reach the last message within 
the current AREA you are reading. A setting of 1 equals YES, navigate to the next area and a setting of 0 
forces NO, and you would have to manually select the next area in which to read messages.

ShowAllAreas=0
ShowAllAreas: This setting    specifies whether or not you will see all conferences within a packet in the 
list box whether or not they currently contain any messages. A setting of "0" specifies NO, show only 
areas with mail, and a setting of "1" specifies show ALL areas.

Signature=Barb in New Hampshire... %Nriding the wave
Signature: Shows the signature you have supplied during program setup. 

AutoSign=0
AutoSign: You may specify whether or not you wish WAVE RIDER to automatically sign your replies and 
new messages. A setting of "1" indicates YES, autosign all while a setting of "0" indicates NO, and means 
you must manually sign using the menu or the signature icon on the toolbar.

SaveLast=2
SaveLast: Save last read is a user selectable setting in setup which tells WAVE RIDER to never save, 
always save, or ask each time whether or not to save last reads.

DefaultPacket=1
DefaultPacket: Wave Rider can be configured to show Blue Wave packets (by extension)    QWK packets 
(by extension), Mail Packets (both Blue Wave and QWK) when you select the file open menu or icon. A 
setting of "0" will indicate that Blue Wave packets will be used as a default, while a setting of "1" will 
indicate QWK packets, "2" will indicate Mail Packets.

AskSaveReply=0
AskSaveReply: You may configure WAVE RIDER to automatically save your replies when you close a 
mail packet ("0) or to ask ("1").

Wrap Areas=1
Wave Rider can be configured to automatically 'wrap' areas when the last message is read. A setting of 
"1" will indicate yes and "0" will indicate no.



IgnoreAllCaps=0
The spell check routines can be configured to alert you when a word is types in all caps or to ignore 
words typed in all caps. A "0" setting tells Wave Rider to advise you when it encounters a word typed in all
caps while a setting of "1" tells Wave Rider to IGNORE all caps.



[Screen]
This setting stores the location and size of the WAVE RIDER Window. Normally there would be no reason
to modify this group of settings.

Left=50
Top=15
Right=890
Bottom=678



[Recent File List]
This shows the list of the four most recently opened mail packets. If you delete a mail packet, the listing is
NOT removed.

File1=C:\PROWIN\MAIL\CRYSTAL.WE3
File2=C:\PROWIN\MAIL\LEOTECH.QWC
File3=C:\PROWIN\MAIL\LEOTECH.QWB
File4=C:\PROWIN\MAIL\CHANNEL1.QWA



[Pick Lists]
This setting specifies the location (as you entered in setup) of the optional address book file, subject list 
file and a taglines file. Wave Rider will use a WINQWK taglines file or any standard ASCII listing with a 
proper DOS file name. You may use any editor to create an address list and SUBJECT list that can create
an ASCII file (such as WINDOWS NOTEPAD).

The PICK LIST section of the WAVERDR.INI    also contains the settings for the FILTERS (also known as 
twit lists or twit filters) that are defined from the OPTIONS MENU.

MsgToPickList=C:\WAVERDR\ADDRESS.WQ
TagLineFile=C:\WAVERDR\taglines.wq
SubjPickList=C:\WAVERDR\SUBJECT.WR
FromFilter=C:\WAVERDR\TWITFROM.WQ
ToFilter=C:\WAVERDR\TWITTO.WQ
SubjectFilter=C:\WAVERDR\TWITMESS.WQ



[Packers]
This setting specifies which archivers/unarchivers WAVE RIDER will use to open and close packets. 
Wave Rider is distributed with internal zip and unzip routines which are compatible with PKZIP 2.04g. 
Syntax is shown below. 

OpenZip=C:\WAVERDR\wruz.exe %f %d -o
CloseZip=C:\WAVERDR\wruz.exe %f %d -c
In the example below, note that PIF's were specified with PKZIP and PKUNZIP - the PIF's themselves 
were configured to run IN a Window. The %f and %d parameters are needed by the WAVE RIDER 
program as they specify file and directory locations. The -m parameter is needed for PKZIP. Note lines 
that have been commented out with a semi-colon (;). These show example external compression and 
decompression programs that can be used and the parameters that should be specified. WUNA may be 
used as an unarchiver only. PKZIP and PKUNZIP will run full screen unless your default.pif was changed 
to run in a window OR you create and specify a PIF for each of these and point to the PIF files in packer 
setup as shown below. ARJ and LHA are also supported formats with the syntax as shown.

;OpenZip=d:\util\wuna.exe -e -m0 -g %f -p%d
;OpenZip=PKUNZip.exe    %f %d
;CloseZip=PkZip.exe -m %f %d
;OpenZip=C:\bin\openpkt.pif %f %d
;CloseZip=C:\bin\closepkt.pif -m %f %d
OpenArj=arj.Exe e %f %d
OpenLzh=lha.Exe e %f %d\
CloseArj=arj.Exe u %f %d
CloseLzh=lha.Exe a /m %f %d\



[Sounds]
Personal Mail=C:\WINDOWS\CHORD.WAV
This entry specifies the WAV file to be used to advise you of personal mail. Wave Rider looks for this 
string and if sound is enabled, will play the specified WAV file if your system is configured with a sound 
card (or the speaker driver). If a sounds card and driver (or the speaker driver) is not present, Wave Rider
will beep when it encounters YOUR mail as long as an entry is made here and it will also beep if it cannot 
play the specified WAV file when a sound card and driver is present.

Enable Sound=1
This setting determines whether or not WAVE RIDER will beep (or use a WAV file) when it encounters 
PERSONAL MAIL. The Personal Mail= setting specifies the name and Enable Sound= 1 specifies YES, 
use sound, and 0 specifies NOT to use sound.



[ReadFont]
Wave Rider allow you to select any font on your system to use when reading incoming messages. You 
may wish to experiment, using the FONT selection menu in Wave Rider to see what works best on your 
system.

Height=-18
Width=0
Escapmenu=0
Orientation=0
Weight=400
Italic=0
Underline=0
StrikeOut=0
CharSet=255
OutPrecision=1
ClipPrecision=2
Quality=1
Pitch=49
FaceName=8514oem



[Search]
Wave Rider stores and remembers the most recent 10 find/search strings entered in the dialog box.

Attributes=8
Last10=reader
Last9=visual basic
Last8=viper
Last7=winzip
Last6=paint shop
Last5=access
Last4=winqwk
Last3=bwcc.dll

Last2=key
Last1=wave rider



[ReplyFont]
Wave Rider allows you to select any monospaced font on your system to be used when replying to 
messages. You can experiment to see which font works best with your system by using the choose font 
dialog box while writing a reply.

Height=-18
Width=0
Escapmenu=0
Orientation=0
Weight=400
Italic=0
Underline=0
StrikeOut=0
CharSet=255
OutPrecision=1
ClipPrecision=2
Quality=1
Pitch=49
FaceName=8514oem



[Write Window]
Wave Rider can optionally save your preferred window size for replies/new messages. This setting is 
established when you select the Window Menu, then SAVE POSITION while replying to a message.

Left=-1
Top=4
Right=925
Bottom=557



[Read Window]
Wave Rider can optionally save your preferred window size for reading mail. This setting is established 
when you select the Window Menu, then SAVE POSITION when reading a message.

Left=0
Top=0
Right=925
Bottom=562



Frequently Asked Questions (FAQ)
Q:    How do I delete a reply?
A:    Replies are stored in a virtual area called "Replies."

1. Choose Replies from the Areas menu. This makes Replies your active window.

2. Choose List from the Messages menu.

3. Highlight the message you want to delete in that list box.

4. Choose Delete.

Q:    How do I move from the top of the reply window to the bottom without using my mouse?
A:    The bottom window of the reply is a pane, to change panes, use the F6 function key.

Q:    Why does WAVE RIDER convert messages packets to BlueWave format before opening?
A:    It was easier to code that way. If we had included both native file formats, the resulting executable 
would have been much larger.

Q:    Why do QWK taglines only allow 57 characters, and BlueWave taglines allow 70 characters?
A:    During early beta testing, every packet format could use 70 characters. However, the ... sequence 
BlueWave taglines use at the beginning of each line caused some mail tossers to puke, so we hard coded
57 characters in QWK mode.

Q:    Can I register via credit card?
A:    You sure can. Crystal Cavern has a credit card door on line to take your order. Choose W from the 
main menu.

Q:    What language is Wave Rider written in?    Why is the unzipper a Visual Basic application?
A:    Wave Rider is written 100% in Visual C++ version 1.0. WRUZ.exe, the zipper/unzipper was written 
with code we purchased from EllTech. Their C routines are not available yet. Once they become 
available, WRUZ's functionality will be added to Wave Rider.

Q:    How do I get my Ansi bulletins?
A:    AnsiView is the ansi viewer spawned by Wave Rider. Choose View, Ansi Message. You will then be 
given a menu of the most common files.
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Glossary of Terms
BBS
DLL
ini
*.NEW
QWK
*.REP
Toolbar



BBS
Bulletin Board System



DLL
Dynamic Link Library



ini
A special WINDOWS file used to store settings



*.NEW
A Blue Wave reply and/or configuration file which is uploaded through a Blue Wave door.



QWK
Mail packet format, compressed



*.REP
Reply file for QWK mail doors



Toolbar
graphical buttons which when clicked perform various menu functions



Many BBS systems request that you use minimal quoting to help keep user costs down (to reduce packet 
size and download time).



Use ONLY when a packet from this particular board does not exist. Do NOT use if a reply (REP or NEW) 
file already exists!



Wave Rider displays the File Open dialog box, in which you can    locate and open the desired mail 
packet.You may open more than one packet at a time with Wave Rider



Before you exit Wave Rider, it is recommended you close all open windows and packets!



Wave Rider will open the file save as dialog box and supply a default file name but it is recommended you
select a name that helps identify the text.



You can CUT from replies and NEW messages only, use COPY for incoming messages.



You can copy from new messages, incoming messages and replies.



Position the cursor first at the point in the message where text is to be inserted.



When this is selected, print dialog box will display



Previously read messages will display in reverse order according to the parameters defined (subject, 
number, etc.)



Use to display messages in order according to the parameters you specified in setup (subject, message 
number, etc.)



Use to see portions of longer messages not currently displayed on your screen.



Use to return to top of message.



A 'fast rewind' between conferences. Note that you must first close any child windows of 'marked' 
messages.



A 'fast forward between conferences. Note that you must first close any child windows of 'marked' 
messages.



Opens a reply window and auto pastes text into this window for you to manipulate.



Also used to EDIT an existing reply. Open the reply and select this icon.



Displays list box, select the conference or area to open by double clicking or by highlighting and selecting 
OK.



You can mark multiple message to read by holding the CTRL key down while clicking to select with your 
mouse.



Position the cursor first, then select this icon. 



Wave Rider's spell checker allows you to add words to your personal dictionary.



Tagline will be displayed in an edit field after icon is selected so that you may edit as you wish.



Places current message in ANSI viewer and accesses ANSIVIEW for bulletins, files, etc.



Opens WAVER RIDER's help file (this file you are now reading).




